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Abstract: 

While wireless communication technology today has become part of our daily life, the idea of wireless undersea communications 

may still seem far-fetched. However, research has been active for over a decade on designing the methods for wireless 

information transmission underwater. Human knowledge and understanding of the world‘s oceans, which constitute the major 

part of our planet, rests on our ability to collect information from remote undersea locations. Although such systems remain 

indispensable if high-speed communication link is to exists between the remote end and the surface, it is natural to wonder what 

one could accomplish without the burden (and cost) of heavy cables. White LEDs (Light Emitting Diodes) in Visible Light 

Communication (VLC) is an emerging technology that is being researched so it can eventually be used for common 

communications systems. LEDs have a number of advantages, one of which is long life expectancy. However, like many 

emerging technologies, VLC has many technical issues that need to be addressed. We proposed an optical indoor wireless 

communication system that used white LEDs like plug-in devices. We developed a practical implementation of VLC and 

demonstrated it experimentally. Hence the motivation and interest in wireless underwater communications. Together with sensor 

technology and vehicular technology, wireless communications will enable new applications ranging from environmental 

monitoring to gathering of oceanographic data, marine archaeology, and search and rescue missions. 

 

Keywords: Visual Light Communication, Decision-Feedback Equalizer, Light Emitting Diode, Light fidelity, Arduino 

Controller. 

 

I.  INTRODUCTION 

 

While wireless communication technology today has become 

part of our daily life, the idea of wireless undersea 

communications may still seem far-fetched. However, research 

has been active for over a decade on designing the methods for 

wireless information transmission underwater. Human 

knowledge and understanding of the world‘s oceans, which 

constitute the major part of our planet, rests on our ability to 

collect information from remote undersea locations. The major 

discoveries of the past decades, such as the remains of Titanic, 

or the hydro-thermal vents at bottom of Deep Ocean, were 

made using cabled submersibles. Although such systems 

remain indispensable if high-speed communication link is to 

exists between the remote end and the surface, it is natural to 

wonder what one could accomplish without the burden (and 

cost) of heavy cables. Hence the motivation and interest in 

wireless underwater communications.  

 

Together with sensor technology and vehicular technology, 

wireless communications will enable new applications ranging 

from environmental monitoring to gathering of oceanographic 

data, marine archaeology, and search and rescue missions. 

Acoustic technology has advantage to transmit data over a long 

distance in water. However, the attenuation of the acoustic 

carrier and the effects of multi-path reflection will ultimately 

limit the data rate and bandwidth for a large amount data 

communication and even at the short range the bandwidth is 

limited to sub-Mbps. This brings a "bottleneck" problem for a 

large amount of data collection (such as multi-sensor data, 

image information, etc.). Wireless optical communication have 

shown promise of supporting large bandwidths, high data 

transfer rate, small in size, low power consumption, immune to 

electromagnetic interference. Thus, underwater wireless optical 

communication can be an alternative method for fast data 

transmission. The optical properties of sea water are function 

of water salinity, water temperature, and concentration of 

dissolved organic and inorganic matter, suspended particles 

and organisms. The attenuation of the light beam in sea water 

is much more serious than in the atmosphere.  

 

Lighting power attenuated in water is mainly dominated by 

wavelength dependent processes: absorption and scattering. 

The main cause of light absorption in water is excitation of 

vibration state of the water molecule by photons and other 

dissolved particles and detritus. Scattering of light refers to 

processes in which the direction of the photon is changed and 

it can take place either on molecules or on dissolved 

particulate. 

 

A) Wave Propagation 

 

Path loss that occurs in an acoustic channel over a distance d is 

given as A=dka(f)d, where k is the path loss exponent whose 

value is usually between 1 and 2, and a(f) is the absorption 

factor that depends on the frequency f. The speed of sound 

underwater varies with depth and also depends on the 

environment.  

 

Its nominal value is only 1500 m/s, and this fact has a twofold 

implication on the communication system design. First, it 

implies long signal delay, which severely reduces the 

efficiency of any communication protocol that is based on 
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receiver feedback, or hand-shaking between the transmitter and 

receiver. 

 
Figure.1.1: Shallow water multipath propagation 

The resulting latency is similar to that of a space 

communication system, although there it is a consequence of 

long distances traveled. Secondly, low speed of sound results 

in severe Doppler With advances in acoustic modem 

technology, sensor technology and vehicular technology, ocean 

engineering today is moving towards integration of these 

components into autonomous underwater networks. While 

current applications include supervisory control of individual 

AUVs, and telemetry of oceanographic data from bottom-

mounted instruments, the vision of future is that of a ―digital 

ocean‖ in which integrated networks of instruments, sensors, 

robots and vehicles will operate together in a variety of 

underwater environments. Examples of emerging applications 

include fleets of AUVs deployed on collaborative search 

missions, and ad hoc deployable sensor networks for 

environmental monitoring. 

D) DECENTRALIZED NETWORK TOPOLOGY 

Depending on the application, future underwater networks are 

likely to evolve in two directions: centralized and decentralized 

networks. In a centralized network, nodes communicate 

through a base station that covers one cell. Larger area is 

covered by more cells whose base stations are connected over 

a separate communications infrastructure. The base stations 

can be on the surface and communicate using radio links, as 

shown in the figure, or they can be on the bottom, connected 

by a cable. Alternatively, the base station can be movable as 

well.  In a decentralized network as shown in fig.1.3 nodes 

communicate via peer-to-peer, multi-hop transmission of data 

packets. The packets must be relayed to reach the destination, 

and there may be a designated end node to a surface gateway. 

Nodes may also form clusters for a more efficient utilization of 

communication channel. Namely, if the relative velocity 

between the transmitter and receiver is ±v, then a signal of 

frequency fc will be observed at the receiver as having 

frequency fc (1±v/c). At the same time, a waveform of 

duration T will be observed at the receiver as having duration 

T (1±v/c). Hence, Doppler shifting and spreading occur. For 

the velocity v on the order of few m/s, the factor v/c, which 

determines the severity of the Doppler distortion, can be 

several orders of magnitude greater than the one observed in a 

land-mobile radio system! To avoid this distortion, a non 

coherent modulation/detection must be employed. Coherent 

modulation/detection offers a far better utilization of 

bandwidth, but the receiver must be designed to deal with 

extreme Dopplerdistortion. 

 
Figure1.2Multichanneladaptivedecision-feedback equalizer  

(DFE) 

(DFE) is used for high-speed underwater acoustic 

communications. It supports any linear modulation format, 

such as M-ary PSK or M-ary QAM. 

 

B) ACOUSTIC MODEM 

Acoustic modem technology today offers two types of 

modulation/detection: frequency shift keying (FSK) with non 

coherent detection and phase-shift keying (PSK) with coherent 

detection. FSK has traditionally been used for robust acoustic 

communications at low bit rates (typically on the order of 100 

bps). To achieve bandwidth efficiency, i.e. to transmit at a bit 

rate greater than the available bandwidth, the information must 

be encoded into the phase or the amplitude of the signal, as it is 

done in PSK or quadrature amplitude modulation (QAM). For 

example, in a 4-PSK system, the information bits (0 and 1) are 

mapped into one of four possible symbols, ±1±j. The symbol 

stream modulates the carrier, and the so-obtained signal is 

transmitted over the channel. To detect this type of signal on a 

multipath-distorted acoustic channel, a receiver must employ 

an equalizer whose task is to unravel the inter symbol 

interference. Since the channel response is not a-priori known 

(moreover, it is time-varying) the equalizer must ―learn‖ the 

channel in order to invert its effect. A block diagram of an 

adaptive decision-feedback equalizer (DFE) is shown in Figure 

1.2. In this configuration, multiple input signals, obtained from 

spatially diverse receiving hydrophones, can be used to 

enhance the system performance. The receiver parameters are 

optimized to minimize the mean squared error in the detected 

data stream. 

 

C). UNDER WATER NETWORKS 

With advances in acoustic modem technology, sensor 

technology and vehicular technology, ocean engineering today 

is moving towards integration of these components into 

autonomous underwater networks. While current applications 

include supervisory control of individual AUVs, and telemetry 

of oceanographic data from bottom-mounted instruments, the 

vision of future is that of a ―digital ocean‖ in which integrated 

networks of instruments, sensors, robots and vehicles will 

operate together in a variety of underwater environments. 

 

D). DECENTRALIZED NETWORK TOPOLOGY 

Depending on the application, future underwater networks are 

likely to evolve in two directions: centralized and decentralized 

networks. 

 
Figure .1.3 Decentralized network topology 

In a decentralized network, nodes communicate via peer-to-

peer, multi-hop transmission of data packets. The packets must 

be relayed to reach the destination, and there may be a 

designated end node to a surface gateway. Nodes may also 

form clusters for a more efficient utilization of communication 

channel [1]. To accommodate multiple users within a selected 

network topology, the communication channel must be shared, 

i.e. access to the channel must be regulated. Scheduling, or 
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deterministic multiple-access, includes frequency, time and 

code-division multiple-access (FDMA, TDMA, CDMA) as 

well as a more elaborate technique of space-division multiple 

access (SDMA). Contention-based channel sharing does not 

rely on an a-priori division of channel resources; instead, all 

the nodes contend for the use of channel, i.e., they are allowed 

to transmit randomly at will, in the same frequency band and at 

the same time, but in doing so they must follow a protocol for 

medium-access control (MAC) to ensure that their information 

packets do not collide. All types of multiple-access are being 

considered for the underwater acoustic systems. Scheduling, or 

deterministic multiple-access, includes frequency, time and 

code-division multiple-access (FDMA, TDMA, CDMA) as 

well as a more elaborate technique of space-division multiple 

access (SDMA). Contention-based channel sharing does not 

rely on an a-priori division of channel resources; instead, all 

the nodes contend for the use of channel, i.e., they are allowed 

to transmit randomly at will, in the same frequency band and at 

the same time, but in doing so they must follow a protocol for 

medium-access control (MAC) to ensure that their information 

packets do not collide. All types of multiple-access are being 

considered for the underwater acoustic systems. 

 

E). UNDER WATER SENSOR 

Generally, the natural disasters are inevitable. Among others, 

water based natural disasters are more dangerous and produced 

huge destruction to the earth. Accordingly, disaster monitoring 

and preventive mechanisms are very necessary. UWSN offers 

a wide range of applications for management and recovery of 

such disasters. More particularly, it relates to the monitoring of 

events that aggravate a disasters aftermath. Along with 

inadequate resources for comprehensive monitoring of the vast 

area of water (e.g., ocean), the task becomes even more 

challenging with occasionally ruthless weather. Therefore, 

efficient monitoring of marine and aquatic dynamics is a 

significant research challenge. UWSN monitoring strategies 

for disaster management and prevention can be formulated into 

a wide variety of applications such as floods, underwater 

volcanic eruptions, and underwater earthquakes and their 

resulting tsunamis, and oil spills which lead to above-the-water 

and underwater ecological instabilities. The repercussions of a 

flood and its increased frequency have pushed the researchers 

to find ways of timely flood alerts. The alerts need not only be 

placed in urban shores and hence require remote deployment. 

UWSN helps develop solutions of underwater sensor 

deployments with over-the-water relay agents to calculate 

aquatic vitals. These vitals are gathered at remote station and 

inspected for flood indications. 

 

II. LIGHT AS COMMUNICATION MEDIUM 

 

A) VISIBLE LIGHT COMMUNICATION (VLC) 

The idea of using light as a communication medium was 

implemented by Alexander Graham Bell in 1880 with his 

invention of the photo phone, a device that transmitted a voice 

signal on a beam of light. Bell focused sunlight with a mirror 

and then talked into a mechanism that vibrated the mirror. The 

vibrating beam was picked up by the detector at the receiving 

end and decoded back into the voice signal, the same 

procedure as the phone did with electrical signals. But Bell 

could not generate a useful carrier frequency, nor was he able 

to transmit the light beam from point to point. Obstacles in 

nature such as fog and rain — which could interfere with the 

photo phone — made Bell stop any future. With the invention 

of LED (Light Emitting Diode), the idea of using light as a 

communication medium has started again. VLC uses white 

Light Emitting Diodes (LED), which send data by flashing 

light at speeds undetectable to the human eye. One major 

advantage of VLC is that we can use the infrastructure around 

us without having to make any changes to it. LEDs‘ ability to 

transfer information signals over light (light which is between 

400THz to 800THz of frequency and whose wavelength is 

between 400nm to 700nm) makes it a very good 

communication medium [2]. 

 

1. MOTIVATION AND OBJECTIVE 

A lot of research is being done to make this technology 

available for commercial use in various fields, including 

Internet access and vehicle-to-road communication using 

traffic signal lights. From our review of the literature, it 

became evident that work should  be done to look into the 

possibility of designing a new model that could fit the present 

infrastructure for indoor applications. Therefore, the objectives 

of the research presented in this work can be summarized as 

follows: 

 Develop a prototype of VLC and demonstrate 

its efficacy by using commercial LEDs. 

Present detailed experimental work on the prototypes and 

discuss the performance. As the contributions of this thesis, the 

models proposed in this thesis were designed with RS-232 and 

USB. As a result, they can be easily integrated with the present 

infrastructure. The first prototype was integrated with the 

existing Terminal Emulation Program (Hyper-Terminal), 

which was already present in the computer. The second 

prototype is designed for simple connection to the computer 

USB comports; it needs Terminal v1.9b software, which is 

available for free. For better understanding of the commercial 

use of the white LEDs for lighting and transmission range, 

illumination distribution and power distribution of the white 

LEDs were then measured and plotted. These designs, when 

truncated further, can be used as plug-in devices for low-cost 

commercial usage. 

 
Figure 2.1: VLC Prototype Model 

The above Fig. 2.1 illustrates the basic idea of the entire model 

design. The basic idea is to make two computers talk with each 

other using free space light propagation. Two models with 

different interfaces were proposed, namely RS-232 and USB. 

Prototype 1 was designed to be compatible with RS-232 

interface and Prototype 2 was designed to be compatible with 

the USB interface. 

 

2. LIGHT EMITTING DIODE (LED) 

In this study, the work is concentrated on the semiconductors 

formed by P-type and N-type materials. Light emitting diode 

(LED) is a PN junction semiconductor that emits light when 

forward biased releases the energy in the form of photons. This 

effect is called as electroluminescence. It is the band gap of the 

LED which is designed for radioactive recombination. When 

joining the N-type and P-type materials, the Fermi levels (Wf) 
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will be aligned and will produce an energy barrier even when 

there is no external voltage applied. 

 
Figure 2.2 LED PN- junction biasing arrangement 

There are two energy bands, namely the conduction band and 

valence band, which are separated by a forbidden region with 

the width of Wg. In the conduction band, electrons not bound 

to individual atoms are free to move [3]. In the valence band, 

unbound holes are mobile and have positive charge. The free 

electrons in the N region cannot go up the barrier without the 

external energy; that is the same for the holes that cannot 

surmount the barrier. By applying a sufficient energy (eV), a 

free electron crosses the barrier, falls into the lower energy 

level and recombines with the hole, releasing the energy in the 

form of photons. 

D) WHITE LIGHT EMITTING DIODES 

Although every color can be produced by LEDs within the 

visible region, white light is the most desirable color for 

general illumination. The visible radiation detectable to the 

human eye is between 480nm to 750nm. White light emission 

from an LED is by mixture of multi-color LEDs or by the 

combination of phosphors with blue/UV LED emission [1]. 

There are different types of white LEDs. Some of the 

important ones are: 

 PHOSPHOR BASED WHITE LEDS 

The InGaN blue LED is coated with phosphor. The wavelength 

converting phosphors is combined with a blue LED to emit 

white light [4], [5]. The chip inside the LED emits blue light 

when external voltage is applied. The emitted blue light passes 

through the yellow phosphor, yielding white light emission. 

 
Figure 2.3: Normalized optical spectrum of a white LED 

From the resulting optical spectrum in Fig.2.3, the left peak is 

due to the blue LED, while the wider right emission 

corresponds to the yellow phosphor. 

 ULTRAVIOLET (UV) BASED WHITE LEDS 

Ultraviolet LEDs were fabricated with pre-coating 

blue/green/red phosphors onto ultraviolet (UV) LED to emit 

white light [4], [5]. 

 RGB (RED-GREEN-BLUE) LEDS 

An RGB (red, green, blue) 3-chip LED is a mixture 

combination of three colors to produce white light with little 

variance in the Kelvin color temperature [8]. We know that the 

visible spectrum of radiation that the sun emits is actually a 

broad range of wavelengths, ranging from red to orange, 

yellow, green, and blue, indigo to violet (ROYGBIV). When 

this broad range of colors impinges on our retina, our brain 

interprets it as ―white‖. A tri-color LED tries to mimic this 

effect by outputting a board range of wavelengths (red, green 

and blue). Note that the three dominant wavelengths of the tri-

color LED are at the ends and the center of the visible 

spectrum, thus attempting to replicate the coverage of the 

range and getting close to (ROYGBIV) as possible (with 

minimal hardware). 

 

III MODES OF OPERATION 

1. Photovoltaic Mode 

Photovoltaic mode, also called as zero bias operation, occurs 

when no external voltage is given to the photodiode. The 

photo-current generated is fixed and also linearly dependent on 

the incident radiation level [3]. 

1. PHOTOCONDUCTIVE MODE 

The diode is reverse biased (cathode positive and anode 

negative), which increases the depletion region width, reducing 

the junction capacitance. This results in faster response time. 

However, in this mode the effects of noise and dark currents 

will be more [3] 

1. VOLTAGE COMPARATOR 

The output of the comparator depends on the differential input 

voltage value. If the difference of the input voltages is positive, 

then the output of the comparator is positive. If the difference 

of the voltages at the input terminals is negative, then the 

output is negative. The output of a comparator is a square wave 

[11]. 

 
Figure 3.1: Voltage Comparator configuration 

D) RS-232 Interfaces 

RS-232 is a single ended electronic data communication 

between the DTE (data terminal equipment) and DCE (data 

circuit terminating equipment) in computer serial ports. It 

supports the bit transmission rate up to 115,200 bps in serial 

communications [12]. 

 
Figure 3.2: DB-9 female connector 

E) UNIVERSAL SERIAL BUS (USB) 

It is the replacement of serial and parallel port communications 

with more efficiency and ease of use that supports a data rate 

of 12Mbps (USB 1.0), 480Mbps (USB 2.0). The new version 

of USB 3.0 can run up to 5Gps. USB was designed in such a 

way that it can connect easily to all the computer peripheral 

devices. It is a hot plug and play with +5v at the source [9], 

[10]. 
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IV. INTEGRATED SYSTEM 

 

This topic discusses the integrated system of White LED 

Visible Light Communication, Power Line Communication. 

An easy wiring system for optical communication using the 

existing power-line is proposed. This system is emitted as 

visible-light from LED lighting according to the transmitted 

signal waveform without demodulating the signal from the 

power-line. This system is expected to be applicable from the 

existing illuminant easily like exchanging electric bulbs [3]. 

 

 
Figure 4.1 System model 

As in optical intensity modulation, the transmitted signals are 

added to the cyclic waveform of the alternating current (AC). 

The transmitter signal from the PC is picked by BPF through 

the power-line, and biased before sending to the LED lights. 

The electrical signal is then converted into an optical signal by 

LEDs and sends it to the photodiode, where it converts the 

captured optical signal to an electrical signal. The signal is 

demodulated according to the received level of light and then 

is passed to the mobile terminal. 

1. ADVANCED DRIVER ASSISTANT SYSTEMS 

Optical communications for outdoor communication has been 

discussed and elaborated upon. Devices such as laptops and 

mobile phones can be used for transmitting and receiving 

information, using transceivers, as shown in Fig. 4.2. 

 
Figure 4.2: General architecture for a full duplex VLC 

system 

Transceiver systems use both LEDs and photodiodes. Intensity 

modulation was implemented to reach the most viable 

modulation. Transceiver systems use both LEDs and 

photodiodes. Intensity modulation was implemented to reach 

the most viable modulation. Various important design 

parameters were optimized by using intensive investigation 

based on gain variation over 100m of transmission range [13]. 

 

2. INTEGRATED COMMUNICATION AND 

LOCALIZATION OF UNDERWATER ROBOTS 

An optical wireless link has been established between the 

Remotely Operated Vehicles (ROV) and gateway station using 

LEDs and Photodiodes on both sides. Underwater ROV was 

used to communicate with the gateway station over water to 

transmit control signals. Both the gateway station and ROV are 

capable of directing a light beam in the three-dimensional 

space [4], 14]. 

 
Figure 4.3 Architecture of the dual-use optical 

communication 

1. RGB LED LIGHTS 

A prototype was designed to demonstrate wireless VLC using 

RGB LEDs and sensors. On the left are the RGB LEDs used as 

signal transmitters. The right side is the RGB sensor, which is 

used as a receiver. 

 

 
Figure 4.4: Outline of the system 

The RGB LEDs enable parallel signal communication, and a 

PSoC microcontroller is used to control them, thus 

significantly reducing the need for extra circuits. Pulse Width 

Modulation was used to switch RGB LEDs at high speeds. The 

characteristics of both the variation in color and change in 

intensity of each RGB LED and RGB sensor were analyzed to 

realize multiple-value signals communication by using RGB 

color [15]. 

 

D) VISIBLE LIGHT COMMUNICATION LINK FOR 

AUDIO AND VIDEO TRANSMISSION 

 

A VLC system to transmit high quality video and audio signal 

was proposed and demonstrated by using illumination LEDs. 

The analog video signal was modulated by using an ultra high 

speed comparator in the transmitter. The analog signal was 

converted from analog to digital. Both the video and analog 

signals were transmitted using the illumination LEDs in the 

transmitter. The photodiode at the receiver senses the optical 

signals from the LEDs and is converted into electrical signals. 

The electrical signal is then amplified to recover the digital 

signal and converted back to an analog signal to video/ audio 

out [16]. 

 
Figure .4.5. Block diagram of receiver module 

 



International Journal of Engineering Science and Computing, May 2018     17832                                                                  http://ijesc.org/ 

V.  ARDUINO MICROCONTROLLER 

 

The popularity of Arduino is steadily increasing and it is fast 

becoming the microcontroller of choice for students, hobbyists 

and smaller companies. Many different electronics PCB 

manufacturing companies are jumping on the bandwagon and 

producing their own variations of the boards, as well as 

―shields‖ (additional circuits that fit directly on top of many 

Arduino boards to increase their functionality) and accessories. 

The Arduino website offers free resources and tutorials as well 

as a language reference to help you understand the code and 

syntax. In order to get started, you will at the very minimum 

need an Arduino board. Note that all the Arduino (and most of 

the clone boards) can use the Arduino software. If you are 

unsure what hardware to get, the Arduino USB is currently the 

most popular model, and these 5 minute tutorials are based 

around it. 

 

1. “Newest:  Arduino Interface 
 

When the software is loaded, the first screen you will see is a 

white window (shown below) with several different shades of 

blue and blue-green as border.  Arduino projects are called 

―sketches‖, several additional files can be created. The main 

headings are ―File‖ ―Edit‖ ―Sketch‖ ―Tools‖ ―Help‖ and 

several shortcut icons beneath ―Verify‖, ―Upload‖, ―New‖, 

―Open‖, ―Save‖, and at the far right, the ―Serial 

Monitor‖. Note that all these icons are also available from the 

main menus. 

 

 
Figure 5.1 Newest: Arduino Interface 

 

The Arduino language is CASE SENSITIVE: a capital letter is 

not the same as a lower case letter. The following code 

represents the minimum in order for a program to compile: The 

―void setup()‖ section is widely used to initialize variables, pin 

modes, set the serial baud rate and related. The software only 

goes though the section once. The ―void loop ()‖ section is the 

part of the code that loops back onto itself and is the main part 

of the code. In the Arduino examples, this is called ―Bare 

Minimum‖ under File-> Examples -> Basics. To add 

subroutines using the same syntax: 

 

void subroutine name() {} 
 

Almost every line of code needs to end with a semicolon ‗;‘ To 

write single line comments in the code, type two back slashes 

followed by the text://comments are overlooked when 

compiling your program To write multi-line comments, start 

the comment with /* and end with */ /* This is a multi-line 

comment and saves you having to always use double slashes at 

the beginning of every line. 

 
Figure 5.2 Arduino code 

 

B) SERIAL COMMUNICATION 

 

The Arduino board can communicate at various baud (―baud 

rates‖). A baud is a measure of how many times the hardware 

can send 0s and 1s in a second. The baud rate must be set 

properly for the board to convert incoming and outgoing 

information to useful data. If your receiver is expecting to 

communicate at a baud rate of 2400, but your transmitter is 

transmitting at a different rate (for example 9600), the data you 

get will not make sense. To set the baud rate, use the following 

code: 

 

void setup() { 

Serial.begin(9600); 

} 

9600 is a good baud rate to start with. Other standard baud 

rates available on most Arduino modules include: 300, 1200, 

2400, 4800, 9600, 14400, 19200, 28800, 38400, 57600, or 

115200 and you are free to specify other baud rates. 

 

1. BLINK LED PROGRAM 

Connect the board to the computer if it is not already 

connected. In the Arduino software go to File -> Examples -> 

Basics -> Blink LED. The code will automatically load in the 

window, ready to be transferred to the Arduino. Ensure you 

have the right board chosen in Tools -> Board, and have the 

right COM port as well under Tools -> Serial Port. If you are 

not sure which COM port is connected to the Arduino, (on a 

Windows machine) go to Device Manager under COM & 

Ports. 

 

 
Figure 5.3 Blink LED Code 

The three new lines of code you have not seen before are: 

pinMode(13, OUTPUT);This sets pin 13 as an output pin. The 

opposite, being INPUT, would have the pin wait to read a 5V 

signal. Note that the ‗M‘ is capitalized. A lower case ‗m‘ 

would cause the word ―pinmode‖ to not be recognized. 

digitalWrite(13, HIGH); and digitalWrite(13, LOW); 

The line digitalWrite(pin, HIGH); 

puts a specified pin high to +5V. In this case we chose pin 13 

since on the Uno, the LED is connected to pin 13. Replacing 

HIGH with LOW, the pin is set to 0V. You can attach your 
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own LED using a digital output and the GND pin. Note that 

the ‗W‘ is capitalized.  

Delay (1000); 

The delay (1000); line causes the program to wait for 1000 

milliseconds before proceeding (where 1000 is just a 

convenient example to get a 1 second delay). 

 
Figure 5.4 Analog Input 

Open the sample sketch ―Analog Input‖ under File -> 

Examples -> Analog. The comments section has been reduced 

below to make the code clearly visible. We see several new 

lines of code here: 

int sensorPin = A0; 

The ―int‖ is short for ―integer‖. The name ―sensorPin‖ was 

chosen only to describe what the variable represents; ―sensor 

pin‖. The fact that the ‗P‘ is capitalized makes it easier to see 

that it is actually two words, since spaces cannot be used. The 

integer ―sensor pin‖ is equal to A0, where ―A0″ is Analog pin 

0 on the Arduino. On its own, ―A0″ is not a reserved term. 

However, when used in context, the system recognizes it as 

analog pin 0. The line must be ended with a semicolon. By 

declaring a variable in the setup, you can use the term, which 

in this case is ―sensor Pin‖, throughout the code instead of 

―A0″. Therefore a voltage of 0V corresponds to a numeric 

value of 0. A voltage of 5V corresponds to a numeric value of 

1024. Therefore a value of 3V would correspond to a numeric 

value of: 

3/5 =x/1024, x = 3*1024/5 = ~614 

Alternatively you could have written: sensorValue = 

analogRead(A0); 

int ledPin = 13; 

Once again, the term ―ledPin‖ is not a reserved word in 

Arduino, it was chosen to describe which pin was connected to 

the LED. The value ―13″ is a normal value, but just like ―A0″, 

when used in context represents pin 13. 

Int sensorValue = 0; 

The term ―sensorValue‖ is not a reserved term either. Connect 

the potentiometer to pins A0, 5V and GND. The middle 

(wiper) lead is the one to connect to the analog pin and the 

voltage varies on this pin. The orientation of the other two pins 

does not matter. The other option is to connect the 

potentiometer to pins A0, A1 and A2. However, you will need 

to add the following code under void setup(): 

 

digitalWrite (A1, LOW); 

digitalWrite (A2, HIGH); 

 

This sets the corresponding pins to 0V (GND) and 5V (PWR). 

Once the potentiometer is connected, upload this sketch to the 

board and change to the Serial monitor. As the knob gets 

rotated (or slide the slider), the values should change between 

0 to 1023. Correspondingly, the LED will blink with a faster or 

shorter delay. You can now read values and use them within 

your code. The new function used here is ―analogRead();‖ 

where the pin selected is pin #2. If you used analog pin #5, you 

would change the code to read: 

int sensorpin = 5; 

If the system does not work, check the syntax and ensure the 

code uploads correctly. Next, check the connections to the 

potentiometer ensuring that the middle lead goes to the correct 

pin, and the other pins are powered at 0V and 5V. 

 Serial.println(sensorValue); 

This sends the value contained in the variable ―sensorValue‖ 

serially via the USB plug and digital pin 1. Verify, then upload 

this sketch to your Arduino. Once it is done, press on the 

―magnifying glass‖ located towards the top right of the 

window. This is the ―Serial monitor‖ and monitors 

communications being sent and received by the Arduino. 

 Serial.print(sensorValue); 

Infrared distance sensors are useful for measuring distances 

without actually touching a surface. The three wires protruding 

from a distance sensor represent +5V (in most cases), Gnd 

(Ground) and signal. These are almost always color coded with 

black as ground, red as +V and white or yellow as the signal. 

 
Figure 5.5 Arduino controller kit 

Infrared distance sensors are useful for measuring distances 

without actually touching a surface. The three wires protruding 

from a distance sensor represent +5V (in most cases), Gnd 

(Ground) and signal. These are almost always color coded with 

black as ground, red as +V and white or yellow as the signal. 

 

D) ARDUINO AND PUSH BUTTONS 

 

Connecting toggle switches, push buttons and momentary 

contact switches to the Arduino is straightforward. A push 

button is a simple device that completes a circuit. One end of 

the button is connected to source, usually a low voltage (5V on 

the Arduino is ideal) and the other connected to the digital pin. 

When the switch is flipped, pressed or toggled, the circuit is 

either opened or closed. The digital pin simply returns if there 

is 5V or 0V. 

The code associated with this is: 

digitalRead(pin); 

In the following simple program, a push button is used to turn 

on the LED connected to pin 13. The line 

digitalWrite(ledPin, status); 

turns the ledPin (in this case assigned to digital pin 13) HIGH 

(1) or LOW (0) depending on the status variable. We initially 

set the status to be low (0). 

 

 
Figure 5.7 Arduino Code using push button is used to turn 

on the LED 
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VI. LI-FI 

 

LiFi is transmission of data through illumination by taking the 

fiber out of fiber optics by sending data through a LED light 

bulb that varies in intensity faster than the human eye can 

follow. Li-Fi is the term some have used to label the fast and 

cheap wireless-communication system, which is the optical 

version of Wi-Fi. The term was first used in this context by 

Harald Haas in his TED Global talk on Visible Light 

Communication. ―At the heart of this technology is a new 

generation of high brightness light-emitting diodes‖, says 

Harald Haas from the University of Edinburgh, UK,‖Very 

simply, if the LED is on, you transmit a digital 1, if it‘s off you 

transmit a 0,‖Haas says, ―They can be switched on and off 

very quickly or simply by changing the light color, which 

gives nice opportunities for transmitted data.‖ It is possible to 

encode data in the light by varying the rate at which the LEDs 

flicker on and off to give different strings of 1s and 0s.The 

LED intensity is modulated so rapidly that human eye cannot 

notice, so the output appears constant. More sophisticated 

techniques could dramatically increase VLC data rate. Wi-Fi is 

basically, light fedility‟ which uses visible light 

communication instead of radio wave communication as in 

WI-FI. As speed of light is way faster than radio waves hence 

it can be used with a speed of around 250 times more than any 

high speed broadband. Day by day use of internet is increasing 

and hence traffic is increasing.  

 

The limitations are overcome by LI-FI which can be used 

for: 

 

1. Large coverage of area 

2. Traffic handling capacity 

3. Cheaper 

 

Li-Fi has the advantage of being able to be used in sensitive 

areas such as in aircraft without causing interference. 

However, the light waves used cannot penetrate walls. 

Moreover Li-Fi makes possible to have a wireless Internet in 

specific environments (hospitals, Airplanes etc.) where Wi-Fi 

is not allowed due to interferences or security considerations. 

Light Fidelity is transmission of data through illumination by 

taking the fiber out of fiber optics by sending data through a 

LED light bulb that varies in intensity faster than the human 

eye can follow. Li-Fi is the term some have used to label the 

fast and cheap wireless Communication system, which is the 

optical version of WiFi. 

 

VII. CONCLUSION 

 

In this topic the main challenges for efficient communication 

are overviewed in under water acoustic sensor networks. The 

eculiarities of the underwater channel with particular reference 

is outlined to networking solutions. The ultimate objective of 

this topic is to encourage research efforts to lay down 

fundamental basics for the development of new advanced 

communication techniques for efficient under water 

communication and networking for enhanced ocean 

monitoring and exploration applications. 

 

• The aim of this is to build an acoustic communication 

• This is not only the way for underwater 

communication 

• By using optical waves which offers higher 

throughput (Mbps) over short distances (up to about 100 m). 
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